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What's new

The improvements detailed below are grouped into topics in alphabetical order, as in the
Reference section of the User Guide. All significant improvements since version 1.3 are
listed. (For a list of the improvements up to version 1.3, visit the User Area of
www.sibelius.com.)

File compatibility
Sibelius v1.4 (and Scorch 2) can open files from all previous versions of Sibelius; i.e. they
are fully backwards compatible.

However, due to a major change to the Sibelius file format, files saved in v1.4 cannot be
opened in v1.3. Thus users wishing to open files saved in v1.4 will have to upgrade to v1.4.

Scorch users will also need to upgrade to Scorch 2 (v1.4) to view scores saved by Sibelius
V1.4

Accidentals
Accidentals can now be dragged horizontally with the mouse or moved using ~o<—/— or
Alt+—/— (N3 «—/— or Ctrl+Alt+«/— move in larger steps).

File conversion
Version 1.4 of Sibelius contains an updated Finale file converter that allows the conversion
of files saved in Finale 2001, as well as Finale 98/2000, PrintMusic and Allegro. Note that
files must be saved as ETF (Enigma) files in Finale 2001 in order to be opened by Sibelius,
though Sibelius can open standard (.mus) Finale 98/2000 files too:

e Before saving your file in Finale 2001, go to the last page and run the Update Lay-
out command. Then save your file as an ETF file

e If you try to open a .mus file from Finale 2001, you will be prompted by Sibelius to
save it as an .etf file in Finale 2001 and try again

o Note also that files from Finale 2000 or 2001 will not open in Sibelius unless you have
updated their layout (choose Update Layout from the Edit menu in Finale) be-
fore saving them and opening them in Sibelius

e This file converter can now open .mus (binary) and .etf (Enigma) files from Finale
98, Finale 2000, Allegro 98, Allegro 2000 and PrintMusic 1.0, and .etf files only from
Finale 2001.
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Note that all converted files have all staves muted by default, so they will be silent on play-
back. To make converted files play back, click Tutti in the Sounds dialog box (Type I).
You may find it necessary to click Reset Sounds, also in the Sounds dialog box, to get
converted files to play back with the correct instrument sounds.

A converter for SCORE files will be available from the User Downloads page at
www.sibelius.com from early November.

In addition, it is no longer necessary to add file extensions to Acorn Sibelius files (.s7) or Fi-
nale files (.mus) to allow Sibelius to open them.

Hint for Windows users: to make files without the correct file extensions display in the
Open dialog box (Ctrl+0), you must set Files of type to All files (not the default All
music files).

Fonts
Sibelius v1.4 and Scorch 2 (v1.4) install new versions of the Opus and Inkpen fonts, includ-
ing many new symbols.

Both fonts have been improved in version 1.4 of Sibelius, as follows:

e Opus and Inkpen fonts are now provided in both TrueType and Adobe Type 1 (Post-
Script) formats on both Mac and Windows (TrueType versions installed by default)

e Inkpen is now, like Opus, embeddable in PDF files, and more symbols have a ‘hand-
written’ appearance

e More symbols have been added to both Opus and Inkpen (see New symbols be-
low).

For most publishing purposes, Adobe Type 1 (PostScript) fonts are preferable to TrueType
fonts. Type 1 versions of both Opus and Inkpen are included in the PostScript Fonts
folder (in the Extras folder within your Sibelius program folder).

Support for Type 1 fonts differs according to operating system, as follows:

e On Mac: you will need to install Adobe Type Manager, included on your Mac OS CD-
ROM

e On Windows 2000: you do not need to install any other software

o On Windows 95/98/Me/NT 4.0: you will need to install Adobe Type Manager; a free
version, Adobe Type Manager Light, is available for download from
www.adobe.com/products/atmlight
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However, PostScript fonts are not required to create EPS files in Sibelius (see Save as
EPS below), or to print to PostScript printers, so you should not need to install them for
these purposes.

Hint for Mac users: if you find that notes are not touching stems, keyboard braces are small,
the music symbols are ‘blocky’ when you zoom in close, etc., you may have installed Post-
Script Type 1 music fonts but not switched on Adobe Type Manager. Switch it on from
Apple » Control Panels » ~ATM. You will then need to restart your computer for the
changes to take effect.

Guitar tab
There are two new TAB clefs (one for 6-line staves, one for 4-line staves) designed to fit in
tablature staves which are slightly larger than the default. The clefs will appear in new scores
only (although you can use File » Import Styles to transfer them to an existing score -
see New symbols below).

Harp pedal diagrams
Sibelius now includes the symbols needed to draw harp pedal diagrams. To input these,
create some Technique text (type #8T or Ctrl+T and click in your score) then type
©387/8/9/+ or Ctrl+Alt+7/8/9/+ on the numeric keypad to obtain, respectively, the
symbol for natural/sharp/flat/vertical line. These are also available from the Technique text
word menu (Control-dlick or right-click when entering text).

'_|T||'_'|- The symbols represent the positions of the pedals in the order DCBEF G A

with a vertical line after B. Thus a diagram consists of typing 8 symbols. A
notch above the horizontal line means flat; below means sharp. The pedal diagram on the
left denotes D flat, C, B sharp, E sharp, F flat, G flat, A.

Internet Publishing
Version 1.4 of Sibelius includes the option of publishing your music online at
www.scorchmusic.com. It is also accompanied by an updated version of the Scorch
browser plug-in called Scorch 2. For more details, see Internet Publishing later in this
booklet.
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Layout and formatting
Snap Object (&+36S or Ctrl+Shift+S) on a selected symbol now snaps the symbol
vertically to align with a staff line or space. This makes it easier to align certain symbols, such
as symbols for accidentals and notes, with the music.

Lines
The House Style option Clip at end of systems (File » House Style » Slurs)
now clips slurs only; there is a new, separate option for ties on the Notes page of the
House Style dialog box.

Lyrics
An elision character (a small slur between two syllables showing they are sung on the same
note) is now included; when entering text in the Lyrics text style (5L or Ctrl+L) use _ (un-
derscore) between elided words instead of space.

Manuscript paper
New manuscript papers are included:

e A4 (larger notes) and Letter (larger notes). As the names suggest, these
manuscript papers use larger than normal noteheads, traditional engraving of a design
recommended by the US Music Publishers Association

e Worksheet manuscript papers to make it easy to create your own educational work-
sheets in various different formats.

Metronome marks
Beamed eighth-notes (quavers), sixteenth-notes (semiquavers), 32nd-notes (demisemi-
quavers) and triplets are now included in text for use in metronome marks. When typing
Metronome mark (#EM or Ctrl+M) or Tempo text, Control-click or right-click to display
the word menu containing the various symbols available.

—3—  For instance, to get two beamed eighth-notes (quavers), use a beamed
Ji=l2 eighth-note followed by a quarter-note (crotchet), which will appear as the
final eighth-note. To get a triplet quarter-note plus eighth-note, as used to show swing time,
type #63 or Ctrl+3 on the main keyboard (not the numeric keypad).

New symbols
Included in the new versions of the Opus fonts are the following, listed as they appear in the
Symbols dialog box (type Z):
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o Repeats: barline, start repeat barline, end repeat barline, final barline. These are use-
ful for scores where some staves have independent barlines.

e General: circle, top of bracket end, bottom of bracket end. The bracket ends can be
put at the top/bottom of repeat barlines as ‘wings’ to make them more visible. (The
bracket ends suitable for making ‘winged’ start repeat bars are also found here.)

e Guitar: vibrato bar scoop, vibrato bar dip.

e Articulation: tick (for breathing), thicker caesura (double slash), vertical ‘notch’ for
staccato in some early music.

» Notes & flags: cluster symbol; by stacking several of them vertically you can make a
cluster chord of any size. Note also the tie symbols which can be used for /aissez vi-
brer (let ring’) and for ties going into 2nd endings and codas.

e Noteheads: small quarter/half/whole (crotchet/minim/semibreve) noteheads, large
quarter/half (crotchet/minim) noteheads.

¢ Conductor: two diagonal arrows for voice-leading in choral music, four downbeat
symbols, four double and triplet beat symbols.

o Clefs: two taller tab clefs - see Guitar tablature above.

e Others: jazz lift and fall; string mute; wind fingerings ‘closed’, ‘half-open’ and ‘open’;
four symbols on stems which you can position on note stems; fingernail; two ‘expo-
nential’ crescendo curves which fit onto narrow and wide crescendo hairpins.

e Accordion: 15 treble coupler diagrams; 13 bass coupler diagrams, as well as an
empty diagram and a blob which you can superimpose to produce further combina-
tions.

Note that the new symbols in Opus and Inkpen have been added to the standard Sibelius
manuscript papers, but they will not be available in existing scores unless you import the
styles from a new score created in v1.4.

We have provided a number of style ‘library’ files in the Extras folder within your Sibelius
program folder, for both English and German versions of Sibelius, containing all the new
symbols. These library files also make it easy to switch between the Opus and Inkpen fonts
in your existing scores.

For most purposes, open your score, choose File » Import Styles, and open English
Opus styles.lib, switching off all options except Symbols, Noteheads, Fonts and
Text styles before clicking OK. Use English Inkpen styles.lib to get a handwritten
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look. English Opus larger notes.lib gives the same look as the new manuscript paper
files (see Manuscript paper above).

Hint for Windows users: with certain printers, music symbols will not print if you use the
new versions of the fonts with older versions of Sibelius or Scorch. To avoid any such prob-
lems, simply ensure that you are running the latest versions of both Sibelius and Scorch 2
with the new fonts.

If you want to find out which version of the fonts you currently have installed, open the
Fonts applet in Start » Settings » Control Panel, and double-click the font.

Noteheads

You can now easily mix normal- and cue-sized noteheads within a chord. Simply select the
noteheads you wish to make small, and choose notehead style 19 (e.g. type 19 on the
numbers along the top of the main keyboard).

We recommend you only create small noteheads this way if normal and small noteheads
are needed in the same chord. To make a single note or whole chord cue-sized, click Cue
on the second keypad layout (type F9), as this will also make the stem and any accents and
articulations small.

These cue-size noteheads are only present in new scores (although you can use
File » Import Styles to transfer them to an existing score - see New symbols
above).

Plug-ins

Version 1.4 includes many new ManuScript plug-ins, plus new versions of existing plug-ins,
and improvements to the ManuScript language itself - for more details, see the Plug-ins
section later in this booklet.

Preferences

10

As of version 1.4 of Sibelius, user preferences are no longer stored in a text file (which was
preferences.txt in the Sibelius program folder). The settings in the Preferences dialog
box (File menu), and other customizable settings such as word menus and keyboard short-
cuts, are now stored in the central Preferences folder inside the System Folder (Mac)
and in the Registry (Windows).

This change makes no difference to the operation of Sibelius, but if you need to access
these settings directly (e.g. to share your customized keyboard shortcuts with another user),
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you will need to export the relevant keys from the Windows Registry or from the Mac's
Preferences folder.

Note that when you first run Sibelius v1.4 after updating, your preferences will have been
reset to their default settings. Once you have set them back as you want them, Sibelius will
then remember them in the future.

In addition, Sibelius” example scores are now installed in a folder called Scores within the
Sibelius program folder on Windows (this has always been the default location on the Mac).
As before, however, Sibelius will prompt you to save your files in the default location for sav-
ing user files (My Documents on Windows, or whichever folder you have specified on
the Mac).

Printing
Sibelius and Scorch 2 both have a new Fit to paper option in the Print dialog box (5P
or Ctrl+P). This scales the score down in size, if necessary, so that it fits within the print
margins of the paper, to avoid the edges of the music being clipped. This is particularly use-
ful for printing Letter sized scores on A4 paper (and vice versa), and for reducing Tabloid/A3
scores onto Letter/A4 paper.

Advanced users: this option actually shrinks the score if necessary so that the page margins
(which you can set in the Document dialog box in the Layout menu) fit inside the
printer's print area. Therefore it is important that titles, page numbers, footnotes etc. stay
within the page margins. If your score is large (say, Tabloid size) so that Fit to paper is
likely to be used to fit it onto smaller paper, you should switch on View » Page mar-
gins to check that everything on the score is within these margins. Otherwise there is a risk
that some items outside the page margins may be dlipped when printing on smaller paper.

In addition, the printing of lines has now been improved such that the Substitute Lines
option should no longer be required by most printers.

Save as EPS (Encapsulated PostScript)
Most publishers and printers prefer to receive music in EPS format for publication, and Si-
belius now allows you to export your music directly as an EPS file.

To save your score as an EPS file, choose Save As from the File menu, and in the dialog
box that appears, set Save as type to EPS Graphics (.eps). Note that the filename
you specify in the Save As dialog box forms the basis for the names of the files created by
saving EPS files, and the eventual filenames will be different.
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When you click Save, another dialog box will appear, allowing you to specify the following:

e Page Range: you can either choose to save all the pages of the score, or you can
specify the range of pages, in much the same way as choosing which pages to print in
the Print dialog box, e.g. you can type 1,3,2-7, 10-23. The page number will be
appended to the filename of each EPS file.

e |f you had selected a passage in the score before choosing to save as EPS, then an ad-
ditional option (Selected Systems) will appear under Page Range. With this
option switched on, only those systems included in the passage will be saved. (The
passage can run over more than one page, as long as you still specify all the pages
you want EPS files for in the Page Range.)

e Folder: you can choose to save the EPS files either in the current location (the loca-
tion folder chosen in the Save As dialog box) or in a location specified here. By de-
fault, the name of the folder will be [filename] EPS where [filename] is the filename
you typed into the Save As dialog box

o TIFF preview: this check box allows you to include a monochrome, uncompressed
TIFF preview in the EPS file, which will allow most graphics programs on both Mac and
Windows to show you a low-resolution preview of the EPS file before printing

o Smallest enclosing rectangle: this check box defines the dimensions of the re-
sulting EPS file. If this option is switched off, the EPS file will use the page dimensions
of the score (including the margins) as the bounding box. With the option switched
on, the EPS will be cropped to the smallest size possible.

e Substitute braces: this check box is the same as the option in the Print dialog
box, and normally you can ignore it. It is switched on by default, and draws braces as a
filled shape instead of as a text character, which solves display problems in some pro-
grams and on some printers. The only reason to switch it off would be if you were us-
ing a non-standard brace, such as the handwritten one in the Inkpen fonts, and
wanted the same appearance in the EPS file.

Note that Sibelius does not embed fonts in the EPS files it produces. This means that the
publisher or printer who wants to use your EPS files must have copies of the fonts used in
the files. You are licensed by Sibelius to supply the Opus and Inkpen fonts to your publisher
or printer in order to print your EPS files, but you must ensure that you have permission to
distribute fonts from other companies.

If you need to embed fonts in your EPS files, there are third-party utilities available that will
embed fonts in existing EPS files, such as Font Includer (wwwy.fontincluder.com).



What's new

You can create EPS files in Sibelius whichever type of fonts you have installed; the TrueType
fonts are installed by default (you cannot have both TrueType and PostScript Type 1 fonts
installed simultaneously).

Because fonts are not embedded in EPS files saved from Sibelius, they will not work cor-
rectly in Microsoft Word. This is due to a problem with Microsoft Word failing to send the
correct fonts to the printer when outputting documents containing EPS files. If you need to
insert Sibelius EPS files into Word documents, open them in a graphics package such as
Adobe lllustrator and convert the font characters to outlines (or ‘paths’), which removes the
need to have the correct fonts installed in order to print the EPS file.

In addition, some graphics programs on the Mac (e.g. Corel Draw 8) may give errors when
opening EPS files from Sibelius; if you get an error message, try saving the EPS file from Si-
belius again with the TIFF Preview option switched off.

If you import EPS files into Adobe lllustrator version 9.0, we recommend that you switch off
Smart Punctuation (Type menu), as this changes certain font characters, causing
some of the Opus and Inkpen symbols to disappear.

Note that EPS files will not print on non-PostScript printers from most programs. Depending
on the program from which you try to print your EPS files, printing an EPS file to a non-
PostScript printer may result either in a blank page, a message informing you that you can-
not print EPS files on a non-PostScript printer, or a low-resolution printout of the TIFF pre-
view image embedded in the EPS file.

Scanning
PhotoScore Lite v1.76 is included on the CD-ROM. This version fixes the following:

¢ no longer freezes just after reading a scanned page (Mac only)

¢ no longer has corrupted output redraw (Windows only)

e stops the floating detail and keypad windows getting lost off the edge of the screen
e a few other minor fixes.

For instructions on how to update PhotoScore Lite to version 176, see
www.sibelius.com.
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Text

The new House Style opton One hyphen maximum (File » House
Style » Text) forces only one lyric hyphen to appear, even if syllables are spaced a long
way apart. This option is switched off by default.

Another new option, Hyphens allowed at start of systems, controls whether a lyric
hyphen can appear at the start of a system if there is a syllable on the first note. This option
is switched on by default.

Bug fixes

e Inversion 1.3, updating slurs in scores saved in older versions of Sibelius to use mag-
netic slurs could, in some circumstances, result in Sibelius hanging. This is now fixed

¢ The problem with opening saved extracted parts (with spaces at the beginning of their
filenames) no longer occurs

e The Finale file converter now aligns staff braces correctly, and guitar tab has been im-
proved

e Problems editing guitar frames (e.g. fret ‘hopping’) have now been fixed

¢ Unpitched instruments are no longer transposed when you transpose a score

e Separate versions of the Opus and Inkpen fonts for Chinese and Korean versions of
Windows are no longer required; the new Opus and Inkpen fonts installed by Sibelius
and Scorch 2 v1.4 will now work correctly with all language versions of Windows

o Missing text characters in the Mac versions of the Opus and Inkpen fonts (e.g. in chord
symbols) fixed

e Problems with the mouse pointer becoming ‘stuck’ in the area of the screen normally
occupied by the navigator have been resolved (Windows only)

Known problem (Mac only)

14

There is a problem with Mac OS 9 Multiple Users and OMS that causes Sibelius to crash on
startup. This will only occur if the user is logged on as anything other than the Owner
(Administrator). It is an OMS problem (not Sibelius) and applies to all applications that
use OMS.

As a workaround, if users wish to use OMS while running Mac OS 9 in Multiple User mode
they must install both OMS and FreeMIDI v1.44 (or higher) and set up FreeMIDI to run in
OMS compatible mode (see www.sibelius.com/users/freemidi.html).
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Internet Publishing

Version 1.4 of Sibelius includes new features to help you publish your music on the Internet,
and also a brand-new version of the Scorch plug-in, called Scorch 2.

Publishing on scorchmusic.com
Whether you're a composer, arranger, teacher or other musician, you can publish your mu-
sic on our new self-publishing web site, www.scorchmusic.com, so anyone worldwide
can view, play, transpose and print it using the Scorch 2 browser plug-in (see Scorch 2
below).

Composers, arrangers, teachers and anyone else can publish on scorchmusic.com - from
coursework to orchestral scores, from early music to avant garde and rock/pop.

It's entirely free to join and publish scores, plus you can make money from it - if you want
to sell your music (rather than provide it for free) you'll be paid a generous 50% of the
price!

You can already submit scores to scorchmusic.com from the website, and Si-
S belius v1.4 also includes a button which does this for you. To get started, open
the Sibelius file you would like to publish online, and click the Publish button
on the Sibelius toolbar (or choose Publish on scorchmusic.com from the File
menu).

Publish

e |f you haven't saved the file recently, you will be prompted to do so first; then save it,
click Publish again

e Your web browser will open and display a web page for you to specify basic informa-
tion about your score, such as its title (if you have previously filled in the Catalog
Info dialog box in Sibelius's File menu for this score, this information will already be
filled in for you)

e Find on your hard drive the score you wish to publish online - click Browse to find
your score

e When you have found the score, click Next. Your computer will then connect to the
Internet and upload your score to scorchmusic.com

o You will be asked to provide further information about yourself and your score - sim-
ply follow the instructions on the screen.
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Note that scorchmusic.com will only publish music to which you hold the copyright, e.g.
original compositions or arrangements of out-of-copyright music. You are not permitted to
publish transcriptions or arrangements of copyright music, verbatim transcriptions or edi-
tions of out-of-copyright music, or scores containing lyrics that are in copyright. For further
details about the copyright restrictions on scores you can publish, please visit
www.scorchmusic.com.

If you experience any problems or have any queries about self-publishing on scorchmu-
sic.com, please email info@scorchmusic.com.

Scorch 2
Version 1.4 of Sibelius includes a new version of the Scorch browser plug-in called Scorch 2,
with new features for e-commerce web sites such as www.scorchmusic.com, and the
rock/pop sheet music site www.sheetmusicdirect.com. Scorch 2 makes scores much
more interactive than ever before: you can now print scores directly from your web browser,
and even change their instruments.

For instructions on installing Scorch 2, see Updating Scorch Plug-in in Updating
Sibelius for Mac or Updating Sibelius for Windows earlier in this booklet.

The Scorch 2 toolbar

Playback controls and tempo slider (Windows only). Print* ~ when the button
Click Play (or type P) to start playback, or click anywhere on says Free you can geta
the score to start playback from that point free sample print

1

@ oDy g — = 4 & S

Fres Mest | Sound Instr  Trangp  Print  Scorch 2

Turn pages Choose which sound Change key and instru- Scorch 2 information
device you use for playback ments* and updates

* option not available on all scores

Note that version 1.4 of Sibelius does not allow the saving of scores as Scorch web pages
that can print or have instruments changed; these options are only available in Sibelius
Internet Edition and if you publish your music on scorchmusic.com.
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Internet Publishing
For more information on saving scores as Scorch web pages, see Internet Publishing
in your Sibelius User Guide.

New versions of Scorch 2 are released from time to time; to find out which version you are
running, Control-click or right-click on a Scorch 2 score - currently it's Scorch 2 v1.4.



What's new in version 1.4

Plug-ins

Version 1.4 of Sibelius includes many new plug-ins, and nearly all the existing plug-ins have
been modified since v1.3 to take advantage of new features in ManuScript. (These new fea-
tures are described in the latest ManuScript documentation - a file called Manuscript
language.htm installed in the Extras folder within your Sibelius program folder.)

Because almost all of the plug-ins are new or improved in version 1.4, they are all detailed
here: this section thus supercedes the Plug-ins section in your Sibelius User Guide.

Note that you cannot ‘undo” a plug-in, so be sure to save your score before running any of
these plug-ins, in case you don't like the results.

Plug-ins marked * are new in vi.4. Where the names of plug-ins differ greatly from those in
earlier versions, their former names are also listed here.

Accel./Rit. Playback

18

Enables the playback of gradual tempo changes through the insertion of hidden metronome
marks.

To run the plug-in, select a single-staff passage over which the change in tempo is to take
place, then choose Accel./Rit. Playback from the Plug-ins menu.

A dialog box will appear. Choose the correct metronome unit from the drop-down list (e.g. if
your score is in the time signature 4/4, choose quarter note), and then simply enter the
desired start and end tempo. When you click Continue, the plug-in inserts a series of met-
ronome marks above the selected staff.

If you have Show text after tilde (~) switched off in the Text page of the House
Style dialog box (File menu), the plug-in may appear to have done nothing; so to see the
inserted metronome marks, switch this option on. In practice, you will probably want to hide
them so they don't clutter up your score.

The improvements in this version of the plug-in are as follows:

o No longer requires the user to enter the first bar number of the selected passage
o Now works on passages containing empty bars
o (Calculates all bar lengths correctly.
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Add Cautionary Accidentals
If an accidental occurs in one bar of a score and then reverts to the pitch determined by the
key signature in the following bar, it is normal to place a cautionary accidental before the
relevant note in the second bar. This plug-in performs that operation for you, either on a se-
lected passage or an entire score, with the option to mark each added cautionary accidental
with the text [CA] (so you can proof-read the changes).

To apply the plug-in to an entire score, type 6A or Ctrl+A to select your whole score, then
choose Add Cautionary Accidentals from the Plug-ins menu.

However, the plug-in can only be applied to a whole score in a single operation if there are
no changes of key in the piece. When starting the plug-in, you will be required to enter the
number of flats or sharps in the key signature; therefore, if there is a change of key in your
score, the plug-in will give you the error message Select a passage that is in a sin-
gle key. To avoid this, select the part of your score up to the first key signature, run the
plug-in, then select the part of your score from the first key change to the next key change,
run the plug-in, and so on.

The plug-in also has a built-in Help function which gives further information on using its
other parameters.

The improvements in this version of the plug-in are as follows:

e Now operates on system passages (e.g. #56A or Ctrl+A selections).

Add Chord Symbols*
Analyses the harmony of your music and automatically adds appropriate chord symbols
above the selected staves. You can choose to analyse any or all of the staves in your score,
and choose where the chord symbols will be inserted.

To run the plug-in, select the desired staves (e.g. the two piano staves) and then choose
Add Chord Symbols from the Plug-ins menu. A dialog box will appear, as follows:
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Add Chord Symbols (¥1.6)

This plug-in inzerts chord symbals by analysing nates across the staves you have selected. Any staff number given
in this dialog box is taken relative to the selection vou have made, starting at 1 at the top of the selection and
endingat 1 at the bottom. Y'ou may have selected zome hidden staves: these ARE counted in the numbering.

Add chord symbals:

= at the start of every bar & every Icmtchet [quarter] ™| from the start of the bar
How ta find root note: Fioot note analysis options:

& Always by to find root nate by analysing the notes V' Prefer Tths. to 2nds.

(" Take root note to be the lowest sounding note v Prefer chords containing a tiad

7 Take root note bo be lowest note in staff no. |:| ™ Use bottom note if the chard has no tiad
Motation options: Iore notation options:

= Inzert chord symbols at eveny specified position [~ Use 'slash’ inversion marks [e.q. G/D)

€ Only insert chord symbol if the root note hag changed [V Only write chords with at least 3 distinct nates

% Only inzert chord spmbol if the chord name has changed .
Motate omissions of:

Put chaord symbols on staff no. of the selection. v Zid: ¥ Gths

MNOTE: If the chord names overlap each other, try turning off [~ Tthe [~ Sthe [ 11ths
the slash notation and omission notation options on the right.

Cancel | Restare defaults... | ()3 |

You can generally leave these settings at their defaults — simply click OK to add chord sym-
bols to your score.

If you wish to change the settings, there are many options for controlling the results, as fol-
lows:

¢ Add chord symbols: at the start of every bar or every note-value from
the start of the bar (where note-value is selected from a drop-down list): this op-
tion determines how often the plug-in will add chord symbols to the score. It looks at
all the notes sounding across the selected staves at every specified time-interval, and
adds the appropriate chord symbol there (subject to the other options below).

¢ How to find root note (radio buttons) and Root note analysis options
(checkboxes): these options control how the plug-in determines the root note of the
chord, which is the most important step in naming the chord. For instance, C¢ and
Ami’ are effectively the same chord (i.e. they contain the same notes), but have dif-
ferent root notes.
If the Always try to find root note by analysing the notes option is se-
lected, the plug-in will attempt to guess the root note by various methods (controlled
by the checkboxes on the right). Sibelius cannot always guess the root note correctly
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(since any note in a chord is a potential root note, and Sibelius can't read the com-
poser's mind - yet!).

If you don't like the plug-in's guesses for the root notes, try using the Take root
note to be the lowest sounding note option. As its name suggests, this de-
faults to assuming that all chords are in root position, with the root note at the bottom
of the chord. Alternatively, you can use the Take root note to be lowest note
in x option (where x is a staff number determined by the user), which reads the root
of the chord from a particular staff.

To control the root note analysis enabled by the Always find root note by ana-
lysing the notes radio button, there are a number of checkboxes on the right:

Prefer 7ths to 2nds: if there is an interval of a 2nd between any of the notes in
the chord, the plug-in should try to place it as ‘7th — Tonic’ rather than ‘Tonic - 2nd' or
any other interval. This option means, for example, that the notes Bb - C - E - G in that

order are recognized as C7 rather than Bb% (b5) or Emi+(#11) or something
else equally improbable.

Prefer chords containing a triad: when this checkbox is selected, the plug-in
will choose the lowest root note that gives the chord a major or minor triad (from the
root) if such a note exists in the chord. If no such note is present, the plug-in will use
other methods to try to find the root note, unless the Use bottom note if chord
has no triad checkbox is selected, in which case the plug-in will default to using the
lowest sounding note in the chord as the root.

Notation options (radio buttons): these options control when and where chord
symbols should be notated on the score, subject to the choices already made at the
top of the dialog box.

Insert chord symbol at every specified position causes a chord symbol to
be written on the score at every position specified by the options at the top of the dia-
log box, no matter whether or not the actual chord has changed.

Only insert chord symbol if the root note has changed: with this option
selected, the plug-in will not insert a new chord symbol if the root has not changed
since the last inserted chord symbol. Note that the chord itself could change, e.g. Cto
C7, but the chord symbol would still be omitted with this option selected.

Only insert chord symbol if the chord name has changed: with this op-
tion selected, the plug-in will only omit a chord symbol if it would be identical to the
last chord symbol inserted, e.g. the second of two consecutive C chords would not be
inserted, but a C7 following a C chord would be written.

2]
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Put chord symbols on staff no. x of the selection: this option determines
where on the score the chord symbols will be inserted, where x is the number of the
staff, relative to the start of the selection, i.e. if you select three staves and want the
chord symbols inserted above the second of these three staves, you would enter 2
here. Note that, as with all staff numbers in this plug-in's dialog box, the numbering
used is relative to the top staff of the selection, which is numbered 1, and includes any
hidden staves that may be included in the selection. If the plug-in seems to give no
output on the score, it may be that you have chosen to insert the chord symbols onto
a hidden staff.

¢ More notation options (checkboxes):
Use slash inversion marks: when selected, the plug-in will notate different
chord inversions in the standard way, by writing the chord symbol followed by a ‘slash’
or oblique (/) and the name of the note at the bottom of the chord. For example, a C
major chord in first inversion would be written as C/E.
Only write chords with 3 distinct notes: when selected, only chords with 3
or more different notes will be notated as chord symbols. This avoids adding ridicu-
lous chord names with lots of omissions at points where only one or two notes are
sounding. However, with this option selected, ‘power chords’ (e.g. C5) will not be in-
serted.
Notate omissions of (checkboxes): these options control which intervals are
marked as omissions if they are missing from a chord in which they would normally
be expected. If, for example, the 5ths option is switched on, and the chord C-E-Bb is
read (and it is decided that the root note is C), then the chord symbol inserted will be
C7 (; 5).
Note that for 7ths/9ths/11ths/13ths, an interval is expected if the chord name
contains a higher-numbered extension. For example, a C13 chord is by default ex-
pected to also contain a 7th, a 9th and an 11th. Such a chord is unlikely to be fully-
voiced in practice, so it is useful to switch off the omission options for some of these
higher extensions - they are off by default.

Add Interval
Formerly Add Interval Above/Below

Although you can easily add a new notehead to a chord using the keyboard shortcut N, it is
useful to be able to add notes to a whole passage of music at once. This plug-in automates
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that process for you: simply select a passage, then choose Add Interval from the Plug-
ins menu.

A dialog box will appear in which you can choose the size of the interval (e.g. a 3rd or a
6th), its type (major, minor, perfect, diminished or augmented), and whether it will be
added above or below the selected passage. To add the notes, click OK.

Add Note Names
Writes A, G etc. above every note in the score. (It writes sounding pitch if you're using a
transposing score.)

To run the plug-in, simply select a passage (or make sure nothing is selected if you wish to
add note names to all staves throughout your score) and choose Add Note Names
from the Plug-ins menu. A simple dialog box appears, allowing you to specify whether the
note names are added in upper or lower case, which text style is used, and whether note
names should be added to the selected passage or the whole score.

The improvements in this version of the plug-in are as follows:

¢ Note names may be inserted in lower case (upper case letters above a staff usually
denote chord symbols)

o The text style in which the text is inserted can be specified (e.g. use the Figured Bass
style to insert the note names beneath the staff)

e The plug-in can now be applied to a selected passage.

Add Text to Multiple Staves*
When working with large scores (e.g. for orchestra) it can be time-consuming to add text
markings to many staves at the same point in the score (e.g. to direct the whole strings sec-
tion to play mf). Although you can quickly copy such markings using ~=-click or Alt+dlick,
this plug-in makes the process even quicker.

The most useful way is to simply Shift-click a single note and then choose Add Text to
Multiple Staves from the Plug-ins menu. You can then add text to all the staves in
your score at the position of a particular note by simply clicking OK. However, you could
also:

o select only the staves to which you wish to add text and then run the plug-in

o simply run the plug-in and specify the position of the text manually without selecting
any staves first.
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Note that this plug-in is designed for inserting dynamic markings in multiple staves, but you
can insert any text in any text style by switching off Choose from a list of common
words and styles in the plug-in’s dialog box.

Add Tonic Sol-Fa*

24

Adds tonic sol-fa notation to either a selected passage or the entire score. Tonic sol-fa is
both a form of musical notation used in vocal music and a system of teaching sight-singing
which depends on it.

Pioneered by John Curwen in 1840s England, and since modified by Kodaly in the twentieth
century, tonic sol-fa notation is based on the moveable doh system of solmization. The
notes of the major scale are named (in ascending order) doh, ray, me, fah, soh, lah, te,
where doh is the tonic, other notes being thus related to the tonic of the moment, which
changes if the piece modulates. Minor keys are treated as modes of the relative major, the
minor scale being solmized as /ah, te, doh, ray, etc. In notation, the notes are abbreviated as
d,r,m, f, s, 1 t Sharps and flats are indicated by change of vowel, sharps to e, flats to a
(pronounced aw); e.g. doh sharpened is de; me flattened is ma. Colons (;) separate one
beat from the next, single dots (.) are used when a beat is divided into two half-beats, and
commas divide half-beats into quarters. Horizontal lines show that notes are to be held over
a beat (or sub-beat) boundary; blanks indicate rests.

The following example, taken from John Curwen’s snappily titled The Standard Course of
Lessons on the Tonic Sol-fa Method of Teaching to Sing, shows how the notation looks in
practise:

9 ﬁu#n y/— n n n T X i | — T | — |
¢ i e— ———— > E— - S JS——— >~ E—
B e e

|d :d |d :d |d —-.r |m - |m s r s |m - |
Come and sing a mer - ry song, Wake the cheer - ful glee,

To use this plug-in, select a passage and then choose Add Tonic Sol-Fa from the Plug-
ins menu. A dialog box appears, in which you should specify the key of the selected pas-
sage. You can also specify which voice to solmize, and various options concerning the way
the tonic sol-fa notation will look. When you are ready to proceed, dlick OK, and the sol-fa
notation will be added to your score.

Note that if your score includes changes in key signature, the plug-in cannot read these
automatically, and thus you will run the plug-in for each section of your score in different
keys. Note also that, by default, the tonic sol-fa notation is added in the Lyrics text style (i.e.
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beneath the staff), so you should either add the real lyrics to your music using the Lyrics
Verse 2 text style (in Create » Text), or manually move any existing lyrics before run-
ning the plug-in, to avoid the sol-fa notation appearing on top of the lyrics.

This plug-in has the following limitations:

e The spacing of barlines may not be correct (these can easily be adjusted by hand af-
terwards)

e Empty pick-up (anacrusis) bars may not be notated correctly
e Qctave suffixes (e.g. d and d,) may not be notated correctly

e The plug-in uses non-standard ‘bridge note" notation for modulation; it is usual to use
subscript and superscript characters, but these cannot be inserted, so the plug-in in-
stead writes [old note] new note

e The plug-in also uses non-standard tuplet markings (> instead of an inverted comma)

¢ Some of the rhythmic markings may be spaced too close (again, this can easily be ad-
justed by hand afterwards).

Augment/Diminish Rhythm*
It is sometimes useful to be able to halve (diminish) or double (augment) all the note-
values in your score, e.g. if you are transcribing early music in which note-values are gener-
ally twice as long as they would be written in modern editions.

To run these plug-ins, select a passage of music and choose Augment Rhythm or Di-
minish Rhythm from the Plug-ins menu. A dialog box appears, in which you can spec-
ify which voice to augment/diminish.

When you click OK, a new score will be opened with the selected passage copied into it in
augmented or diminished form. The plug-ins copy time signatures (halving or doubling
them as appropriate), and insert ties as appropriate.

These plug-ins have the following limitations:

o Key signatures are omitted

No other objects (e.g. grace notes, lines, clefs, symbols) are copied

Pitches may be spelt incorrectly (e.g. Gb as F#)

Tuplets are omitted, but the rest of the bars in which they appear are copied correctly
Bars of irregular length (e.g. pick-up or anacrusis bars) may not be copied correctly.
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Check for Parallel 5ths/8ves
Checks for fifths and octaves between any pair of staves (although it doesn't check between
voices on the same staff). To use this plug-in:

e (lick any bar in one of the staves you want to compare, so the bar is enclosed in a
blue box

o Shift-click the other staff you want to compare
e Choose Check for Parallel 5ths/8ves from the Plug-ins menu

e In the dialog box that appears, choose whether to check for fifths or octaves, or both,
and whether to check the selected passage or the entire score

e Click OK - and after a few moments of busy activity, Sibelius tells you how many er-
rors it found, which are marked in the score as text. (The warning text starts just over
the second offending note of the parallel 5th/8ve.)

Check Score
This plug-in allows the user to run any combination of three proof-reading plug-ins:

e Check Pizzicatos writes warnings in the score where an ‘arco’ or ‘pizz." seems to
be extra or missing

e Check Repeat Marks writes warnings in the score where a start or end repeat
seems to be extra or missing (i.e. the repeat marks don't match up)

e Check Clefs writes warnings in the score where a dlef is repeated, e.g. an alto clef
would be repeated if you omitted a change to treble clef in a Viola part.

These plug-ins can also be run separately by choosing them from the Plug-ins menu.

Convert Acorn Sibelius Files in a Folder
Batch converts all Acorn Sibelius files found in a specified folder.

Convert Finale Files in a Folder
Batch converts all PrintMusic 1.0, Finale and Allegro 98/2000, and Finale 2001 ETF files in a
specified folder.

Convert MIDI Files in a Folder
Batch converts all MIDI files in a specified folder. Note that these files should be Standard
MIDI Files (with the file extension .mid on Windows) to be properly converted by Sibelius.
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Copy Text*
Copies all text objects of a particular text style from one stave to another in a single opera-
tion. This is especially useful for making dynamic markings play back on both staves of a
keyboard instrument.

To use this plug-in, select a single-staff passage or the entire staff from which you want to
copy text - e.g. triple-click the right-hand piano staff — and then choose Copy Text from
the Plug-ins menu. A dialog box will appear, allowing you to specify which text style is to
be copied (select it from the drop-down menu, e.g. ‘Technique’ or the default ‘Expression’),
and to which staff the text should be copied (note that when specifying the destination staff,
you must count hidden staves as well as visible ones). You can also choose whether the
copied text should be hidden (i.e. preceded by a tilde) in the destination staff.

In keyboard music, the quickest way of adding dynamics to the left-hand staff is to select
both right- and left- hand staves, run the plug-in, and make sure that the 2nd staff in se-
lection check box is selected (it's selected by default).

Note that if you choose to hide the text in the destination staff, it will only actually disappear
if you have switched off the Show text after tilde (~) option in the Text page of the
House Style dialog box (File menu).

Cresc./Dim. Playback
Enables the playback of crescendos and diminuendos over single held notes for appropriate
instruments (particularly wind, strings and singers). Sibelius does not automatically play back
hairpin markings over single notes because it uses MIDI velocities to achieve gradations of
dynamic on a per-note basis. Since a single note can only have a single velocity, a change in
dynamic over a single note must be achieved with the MIDI volume message. This plug-in
inserts a series of MIDI volume messages in order to change dynamics.

To run this plug-in, select a bar or a passage containing the hairpin(s) you want to process.
If you just want to process one hairpin, the best way to do this is by Shift-clicking the hair-
pin and running the plug-in. Note that you only have to select the bar in which the hairpin
starts, not the one in which it ends.

When you have made your selection, choose Cresc./Dim. Playback from the Plug-
ins menu. A dialog box will appear, allowing you to choose whether you wish to process
every hairpin in the selected passage or just the first hairpin.
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Note that the plug-in will not affect playback unless you put a hairpin in your score before
running it - you can always temporarily insert a hairpin and then delete it after you have run
the plug-in (this will not delete the MIDI messages).

If you have Show text after tilde (~) switched off in the Text page of the House
Style dialog box (File menu), the plug-in may appear to have done nothing; so to see the
inserted MIDI messages, switch this option on. In practice, you will probably want to hide
them so they don't clutter up your score.

The improvements in this version of the plug-in are as follows:

e The plug-in now recognises hairpins so the user doesn't need to enter text objects to
denote the start and finish of the dynamic change.

Delete Notes From Chords

Allows you to delete particular notes from chords in a selected passage. Select the passage
from which you wish to delete notes, and choose Delete Notes From Chords from
the Plug-ins menu.

A dialog box will appear, enabling you to choose which notes to delete (or not to delete),
and to ignore chords of fewer than a certain number of notes (so as, for example, to leave
unison passages alone). When you are ready to proceed, click OK.

The plug-in also has a built in Help dialog box which gives some useful tips.

Find Range
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Formerly Tessitura (or Calculate Tessitura)

Calculates the range (i.e. lowest and highest notes) and average pitch of a selected passage.
This is useful if, for example, you are writing vocal music and want to know what kinds of
demands you are placing on your singers.

To run this plug-in, select a passage (or triple-click a staff to calculate its range throughout
the score) and choose Find Range from the Plug-ins menu.

This version fixes a bug whereby the plug-in would not exit if the selected passage consists
of empty bars.
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Keyboard Reduction
Creates a single- or two-staff reduction of a larger score. To use this plug-in, either select the
passage you wish to reduce and run the plug-in, or if you wish to create a reduction of the
whole score, simply choose Keyboard Reduction from the Plug-ins menu.

A dialog box appears allowing you to specify the destination of the reduction (either into the
top staff or staves of the existing score, or, by default, a new score) and whether it is to be a
single- or two-staff reduction. To create the reduction, simply click OK.

Note that the resulting reduction will use only voice 1.
The improvements in this version of the plug-in are as follows:

e The plug-in now gives the option of creating a new score into which to write the re-
duction

e Although the plug-in is still unable to copy tuplets, it is now able to copy the rest of the
bars in which the tuplets appear

e The plug-in now reads and writes time signature changes without any user interven-
tion.

Make Layout Uniform
Formerly Format Score

Forces your score to have a specified number of bars per system and system per page. The
default of 4 and 4 is suitable for voice or solo instrument with keyboard accompaniment.
Solo keyboard music typically has 4 bars per system and 6 systems per page. Music for a
single-staff instrument typically has 4 bars per system and 10 systems per page.

If you wish to format your entire score, make sure nothing is selected (type Esc) and
choose Make Layout Uniform from the Plug-ins menu. You can choose to format
only a selected passage instead: simply make your selection and then run the plug-in.

If you don't like the resulting layout, type #8A or Ctrl+A to select your entire score and
then choose Unlock Format from the Layout menu (or type 38U or
Ctrl+Shift+U).
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Make Pitches Constant

Formerly Transpose to One Note

Makes pitches of all the notes in a selection constant (i.e. the same pitch). This is useful for
creating a percussion line with the same rhythm as a pitched instrument.

To use this plug-in, copy the melodic passage you wish to process into a percussion staff,
make sure the copied passage is selected, then choose Make Pitches Constant from
the Plug-ins menu. A dialog box appears, in which you specify the MIDI pitch to which
you wish to move all the notes. When you click OK,; all the pitches in your selection will be
made constant.

Print Scores in a Folder

Prints all Sibelius files in a specified folder. This is particularly useful for printing a set of ex-
tracted parts with a single click!

Quarter-tone Playback

Inserts the MIDI messages necessary for the correct playback of quarter-tones. To use this
plug-in, either select a passage or the whole score (using #5A or Ctrl+A), then choose
Quartertone Playback from the Plug-ins menu.

A dialog box appears, allowing you to choose the amount of pitch bend required to produce
a quarter-tone. Usually you should leave this at the default - so just click OK.

Note that if you have Show text after tilde (~) switched off in the Text page of the
House Style dialog box (File menu), the plug-in may appear to have done nothing; so
to see the inserted MIDI messages, switch this option on. In practice, you will probably want
to hide them so they don't clutter up your score.

This plug-in has a built-in Help dialog box which describes its operation and limitations in
more detail.

Remove Rests*
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Removes rests in the selected passage of music. If you find that you end up with unwanted
rests after Flexi-time input or importing a MIDI file, you can use this plug-in to ‘clean up’ the
music.

For example, the following music:
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is re-written as:
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by running this plug-in.

To use this plug-in, simply select the passage from which you want to remove rests, and
choose Remove Rests from the Plug-ins menu. A dialog box appears, asking you from
which voice you want to remove rests; when you click OK a new score is created, contain-
ing the cleaned-up music.

This plug-in has the following limitations:

Key signatures are omitted

No other objects (e.g. grace notes, lines, clefs, symbols) are copied

Pitches may be spelt incorrectly (e.g. Gb as F#)

Tuplets are omitted, but the rest of the bars in which they appear are copied correctly
e Bars of irregular length (e.g. pick-up or anacrusis bars) may not be copied correctly

Respell Flats as Sharps/Respell Sharps as Flats
Alters the enharmonic spelling of accidentals in the selected passage. Simply select a pas-
sage, choose Respell Flats as Sharps or Respell Sharps as Flats from the Plug-
ins menu, and all flats/sharps in the selected passage will be respelled.

Retrograde*
Creates a retrograde version of the selected passage - in other words, it turns the music
backwards.

For example, the following passage:

0 Pr—
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g " =

is rewritten as:

by running this plug-in.
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To use this plug-in, select the passage you which to retrograde, and choose Retrograde
from the Plug-ins menu. A dialog box appears, asking you to specify which voice you want
to retrograde. When you click OK, a new score will be opened containing the resulting mu-
Sic.

This plug-in has the following limitations:

o Key signatures are omitted

No other objects (e.g. grace notes, text, lines, clefs, symbols) are copied

Pitches may be spelt incorrectly (e.g. Gb as F#)

Tuplets are omitted, but the rest of the bars in which they appear are copied correctly
Bars of irregular length (e.g. pick-up or anacrusis bars) may not be copied correctly.
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License agreement

By installing or using any component of the Software, or by registering the Product, you (an
individual or legal entity) agree with the Licensor to be bound by the terms of this License
which will govern your use of the Product. If you do not accept these terms you may within
14 days of purchase return the Product, its packaging and documentation unused and intact
to your supplier together with dated proof of purchase for a full refund.

The Product is copyright © Sibelius Software Limited 1987-2000.

1. DEFINITIONS

In this License the following words and expressions have the following meanings:

“License”: this agreement between you and the Licensor and, if permitted by the context, the conditional

license granted to you in this agreement.

“Licensor”: Sibelius Software Limited, an English company (registered no. 3338819) of 66-68 Hills Road,
Cambridge CB2 1LA, UK.

“Product”: the Software and the Documentation.

“Software”: Sibelius for Windows/Mac, Scorch, PhotoScore Lite, Sibelius plug-ins, Opus font family, Inkpen

font family, example music files, installer, and any other programs or files supplied to you on
or with the Sibelius CD-ROM or download.

“Documentation”: the Sibelius User Guide, Sibelius keyboard shortcut tower and any other documentation

relating to the Software supplied to you in any form by the Licensor or with the Software.

2. License

2.1

22

The Licensor grants to you a non-exclusive non-transferable license to use the Software in accordance with
the Documentation on a single terminal of a single computer in a single location. Any further use is prohib-
ited. After you have installed any or all of the Software on your computer you may only use any of the Soft-
ware on another computer if you first delete all of the Software from the first computer. Unless expressly
permitted by the Documentation, you shall not install or use the Software on a terminal or computer on a
network if it can be used (either simultaneously or non-simultaneously) by any other terminal or computer
on the network. Title to the Product is not transferred to you. Ownership of the Product and any back-up
copy of the Software made by you under Section 2.2 remains vested in the Licensor, subject to the rights
granted to you under this License. All other rights are reserved.

Insofar as it is technically possible, you may make one back-up copy of the Software. For the purposes of this
License a back-up copy means a non-saving copy only useable in the event that the Software is unable to be
used on the computer it is first loaded onto or in accordance with the instructions in the Documentation. Any
back-up copy you make will be subject to the terms and conditions of this License in all respects. You may
make one printout for your own use of any part of the Documentation provided in electronic form. You shall
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not make or permit any third party to make any further copies of any part of the Product whether in eye or
machine-readable form.

You shall not, and shall not cause or permit any third party to,

(1) translate, decompile, disassemble, decode, or reverse engineer the Product in whole or in part for any
purpose; or

(2) enhance, modify, alter, adapt or create derivative works based on the Product for any purpose (including
without limitation for the purpose of error correction) except as expressly permitted by the Documenta-
tion; or

(3) translate, convert, decode or reverse engineer any file in any version of the Sibelius or Scorch formats
(whether created by your copy of the Software or not), or modify any such file (except by using the Soft-
ware in accordance with the Documentation), in whole or in part for any purpose; or

(4) cause the whole or any part of the Product to be combined with or incorporated into any other program,
file or product for any purpose, except as expressly permitted by the Documentation.

In accordance with the Documentation and subject to compliance with Section 2.1, the Software's "Save as
Scorch Web Page" feature and Scorch web browser plug-in may be used to publish music scores on the
Internet or by means of CD-ROM, floppy disk or by other similar means; provided, however, that you shall
not and shall not permit any third party to, directly or indirectly, charge or receive any fee, payment or other
consideration for the viewing, playing, printing or other use via Scorch or via the Internet of any file which is
created by (or based on any file created by) the Software, unless expressly permitted by the Licensor in writ-

ing.

The Product or any part of it must not be used to infringe any right of copyright or right of privacy, publicity
or personality or any other right whatsoever of any other person or entity, including without limitation in-
fringement of any such right by use of the Product in conjunction with either of the scanning programs Pho-
toScore or PhotoScore Lite, or by use of the Product's Internet publishing capability.

3. Copyright
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You acknowledge that copyright in the Product as a whole and in the components of the Product as be-
tween you and the Licensor belongs to the Licensor or its licensees and is protected by copyright laws, na-
tional and international, and all other applicable laws. Further details of the ownership of all copyright in the
components of the Product are set out in the Documentation.

4. Liability of the Licensor

34

4.1

42

The Licensor warrants that the Product will be free from defects in materials and workmanship and perform
substantially in accordance with the Documentation under normal use for a period of 90 days after the date
of original purchase (the "Warranty Period"). If a defect in the Product shall occur during the Warranty Pe-
riod, the Product may be returned with dated proof of purchase to the Licensor who will at its sole discre-
tion either return the price paid or repair or replace it free of charge.

The Licensor shall not be liable for any claim arising from:
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(1) any failure or malfunction resulting wholly or to any material extent from your negligence, operator
error, use other than in accordance with the Documentation or any other misuse or abuse of the
Product;

(2) any loss of or corruption to any data, however caused, where such loss or corruption could have
been avoided or corrected or substantially reduced if you had taken and retained in a secure place
appropriate backup copies;

(3) the decompilation or modification of the Software or its merger with any other program or any main-
tenance repair adjustment alteration or enhancement of the Software by any person other than the
Licensor or its authorized agent;

(4)  the failure by you to implement recommendations previously advised by the Licensor in respect of,
or solutions for faults in, the Product;

(5) any loss or damage whatsoever resulting from any omissions or inaccuracies in any information or
data contained in the Product.

(6)  Except as otherwise expressly provided in Section 4.1, all conditions, warranties, terms representa-
tions and undertakings express or implied, statutory or otherwise in respect of the Product are hereby
expressly excluded.

(7)  Except as expressly provided in Section 4.1, the Licensor shall have no liability to you for loss of prof-
its, revenue or goodwill or any type of special, indirect or consequential loss (including loss or dam-
ages suffered by you as a result of an action brought by a third party) whether such loss is caused by
the Licensor's breach of its contractual obligations hereunder or any negligence or other tortious act
or omission.

(8)  The Licensor's entire liability for breach of its covenants and warranties in this License and for any
defect or errors in the Product shall (except as expressly provided in Section 4.1) be limited to the
price paid by you for the Product.

5. Termination

5.1

This License shall terminate automatically upon your destruction of the Product and any back-up or other
copies of the Product or any part thereof. In addition, the Licensor may elect to terminate this License in the
event of a material breach by you of any condition of this License or of any of your representations, warran-
ties, covenants or obligations hereunder. Upon notification of such termination by the Licensor, you will
immediately delete the Software from your computer, destroy any back-up or other copies of the Product
or any part thereof and return the Product to the Licensor.

6. Miscellaneous

6.1

6.2

No failure to exercise and no delay in exercising on the part of the Licensor of any right, power or privilege
arising hereunder shall operate as a waiver thereof, nor shall any single or partial exercise of any right,
power or privilege preclude any other or further exercise thereof or the exercise of any other right, power or
privilege. The rights and remedies of the Licensor in connection herewith are not exclusive of any rights or
remedies provided by law.

You may not distribute, loan, sub-license, rent, lease (including without limitation renting or leasing a com-
puter on which the Product is installed) or otherwise transfer the Product to any third party without the Li-
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6.3

6.4

censor’s prior written consent, which the Licensor may grant, condition or withhold in the Licensor’s sole
discretion.

This License is intended by the parties hereto to be a final expression of their agreement with respect to the
subject matter hereof and a complete and exclusive statement of the terms of such agreement. This License
supersedes any and all prior understandings, whether written or oral, between you and the Licensor relat-
ing to the subject matter hereof.

This License shall be construed and enforced in accordance with and governed by the laws of the State of
California. Any suit, action or proceeding arising out of or in any way related or connected to this License
shall be brought and maintained only in the United States District Court for the Northern District of Califor-
nia, sitting in the City of San Francisco. Each party irrevocably submits to the jurisdiction of such federal
court over any such suit, action or proceeding. Each party knowingly, voluntarily and irrevocably waives trial
by jury in any suit, action or proceeding (including any counterclaim), whether at law or in equity, arising
out of or in any way related or connected to this License or the subject matter hereof.



